How to contribute species information to Radiolaria.org

Jane K. Dolven and Hans A. Skjerpen (October 2004)

Radiolaria.org welcomes you to add information to the database. Your contributions can
help build this site into a useful resource for all radiolarian researchers.

Adding information can be done in several ways. A contributor can add a species by
selecting the stratigraphic/geographic location where the species is known to be present
and click on the “Add species” link on top of the page. This will take the contributor
through several steps (pages), where different forms are filled out. In form one (Species
and original description) and two (Other description), the genus and species name along
with at least one description (including author and year) is inserted. Synonym(s) and
Reference(s) are entered in form three, and Image(s) with related information is added in
form four. All fields marked with an asterisk (*) are required fields that need to be filled
in order to submit the data into the system. Once the data entry is completed, the user can
preview the contributed information. After approval, the data is submitted along with the
contributors name and e-mail address.

A user may also add single pieces of information to a species that is already registered in
the system. This is done by selecting the species of interest, locating the “Add”-link on
top of each page in the submenu (e.g. Add description, Add image, Add
synonym/reference), filling out form(s), and submitting the information.

When data are submitted into the system (either way described above), it is not instantly
made visible on the site, but placed in an administration area and flagged for review.
Web-editors are allowed to log on to the administration system (with a username and
password) and check submitted material flagged for review. A web-editor is assigned a
certain geographic or stratigraphic area, according to his/her expertise, and reviews all
information related to this area. The role of web-editors is to ensure that the information
submitted: 1) is (with regards to species descriptions, synonyms and references) based on
published material with correct citations; and 2) that the images, distribution and web-
links are correctly assigned. If the web-editor finds errors, or judges the data entry to be
insufficient or wrong, and needs to contact and discuss with the contributor, he/she can
use the name and email that was submitted with the content. The review process
(checking of submitted material before it is made online on the website) also prevents
intentional sabotage by online pranksters.

What to add, how to do it and standard formatting of text

The goal of the Radiolaria.org-project is to gather high-quality information about
radiolarians from all time periods and make this available online. One way to acquire data
of good quality is to use information published mainly in peer-reviewed books, journals
and electronic publications. In Radiolaria.org we are basing the content of species names,
descriptions, synonyms and references solely on published data. It is important that these
citations are correct. Non-published info can be placed in the discussion/comment section
under each species.
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Before you start adding information, please make sure it is not already in the system. You
can check this by using the search-functionality at www.radiolaria.org/search.htm, and
there search for e.g. species, synonyms and descriptions.

As mentioned above, the information is added by filling out forms (e.g.
http://www.radiolaria.org/add help.htm). The forms contain certain required fields which
must be filled out before submitted. These are marked with * (an asterisks). Most forms
also include examples of how the text should be formatted. Please try to follow these
examples as this will help us process and display the information in a uniform way.

Adding info about a new (i.e. unregistered) species:

Name

Fill in the name of the species (e.g. Cycladophora davisiana). The system will
automatically write this in italic.

Author(s)

If one author write: last name (e.g. Ehrenberg).

If two authors write: last name and last name (e.g. Nigrini and Moore)

If three authors or more write: “last name of first author” et al. (e.g. Bjorklund et al.)

Write the species author name in parenthesis if the genus name has been changed after
the original description (Use the rules of the International Code of Zoological
Nomenclature).

Radiolario.ovg |Home>

Intro P species P other descrption P synonymireference P image P preview

Species and original description (* are recuired fields)

* MName [e.g. Cycladophora davisiana) Crnginal description

IRhiZDpIegmabGreale Hexadoras borealis: =]
Primordial shell: irregularly spherical, 0.03 to

*Author(s) [E:.g. Ehrenberg] O.04rmm in disteter with irrecular, .rounded Dr_
polygonal pores, 2 to 3 on the radius, and thin

I(Cle\"e) hars. Spines six, excepticnally more, Strong,

with triancular apophyses in the middle.
* Year [e.g 1862]
|1399 Cuter shell: a rounded or octahedral, more or

less intricate network of anastomosing, silicecus

*Type threads, issuing from the proxiwal edges of the
. . . i . Spines usually =six (rarely as in
IS & IS spines
Nassellaria Spmneﬂma Phasodaria Rhizoplegma S5 to 10) strong, three-sided, and
*Oﬁ@nalAppearance z2lightly spirally twisted, with elegantly
I Nordic Seas j aculeate, winged edges.

[ |

Insert |

Please write the name that Cleve used in 1899 (Hexadoras borealis) on top of his description.

Remember to click “Insert” before you continue to “Other description” or “syn/refs”.
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Year
Use four numbers (e.g. 1862).

Type
Check off one of the following: Nassellaria, Spumellaria or Phaeodaria. This will decide
where the species will be displayed on the web page.

Distribution (Original Appearance)

The distribution is selected by using the pull-down menu. When you add information on
the distribution of a species please make sure that the species has been documented
(described/pictured) in one or more papers (and please add this info under
synonym/references). If the species has not been documented in the period/area by a
publication, please make sure to add a photo with information about sample location,
latitude/longitude, period etc.

Original description or other Description

When adding a species you need to include either the original description or another
description that has been published (you can also add both). It is important that this text is
correctly quoted. If you have the description already in a text-file you can easily copy and
paste it into the form-box.

Radiolarvia.ovg |Home

Intro P species P otherdescription P synonymireference P image b preview

Other deseription (optional)

Author(s) Descrliptmn . __

IJEirgensen Ea=ily recognized by the characteristic ﬂ
interwoven pyramids around the main
spine=s. Haeckel depicts simwilar

Vear pyrawmids for Rhizoplegwa lychnosphera.

IW The inside shell is irregular, hot

gquite round; sowetimes resembling a LI

Insert

Synonyms
When adding a species (with name, original author and year) make sure to also use this
information under the first synonym.

Plate/figure format:
If only plate write: pl. 2
If plate and figure write: pl. 2, fig. 1
If plate and figures write: pl. 2, figs. 1-6
If several plates and figures write: pl. 2, figs. 1-6; pl. 4, fig. 3
If only figure(s) write: fig. 2 (or figs. 2-4)
If only page write: p. 297
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References

Search for a reference by writing in the author name [if you do not have "&/0/4”, e.g.
Bjerklund - you can search for "lund"] and click on the “Find Reference” button.

Radiolario.ovg |Home>

Intro P species P other description P synonymireference P image P prewiew

Synonyms new

* Synonym [e g Cycladophora davisianal

|Hexaduras borealis
* Luthor [e.g Ehrenberg]

Reference

an

* Zearch for reference by author name [if vou do not have "=/a/a", e.g.
Bietldund - you can search for "lund"]

|Cleve

|Cleve
* Year [e.g 1862]

|1899

* Plateffigure [e.g p. 257]
[l. 2. ig. 4

Insert |

Tour registered svnonyms & references

| Find Reference I

Radiolowria. ovg | Home>

Intre P species P oother description P synonymireference P inage P preview

Synonyms new

* Synonym [e.g Cycladophera davisiana)

IHexadDras borealis

* Author [e.g. Ehrenberg]

ICIeve

* Tear [eg 1862]
fiags

* Plateffigure [e.g p. 297]
[pl. 2. fig. 4

Reference

* Search for reference by author name [ff you do not have "=//d", e.g
Byarldund - vou can search for "lund")

ICIeve

Find Reference |

Reference Search Results

(Click number to select). Light gray results are references that we hawe
not yet validated.

ﬂ Clewe, P. T, (1893a) Plarkton collected by the Swedish Expedition to

Spitzhergen in 1898 Kingliza Svenska Vetenskaps Akademiens
Handlingat, wol 32 (31 1-31

gaz| Clewe, P. T, (18950 Plankton researches in 1897 Kongliga Svenska

Matarolrarmealadamione handlivmary wwal 33 w0 7T 1 37

When you have located the correct reference click on the attached number to add it (e.g. 21)

If you can not find a particular reference, please send the complete reference info to
jane@radiolaria.org, and it will be added for you.
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Radiolaria.org |Home=

Intro P species P other description P synonym'reference b image P preview

Synonyms new Reference

* Synonym [e.g Cycladophora davisiana] Author{s):

IHexaduraS borealis Cleve, P. T,

* Suthor [e.g Ehrenberg] Year:

|C|EVE 18592
Title:

kS

%g. 1862] Plankton collected by the Swedish Expediion te Spitzbergen m 1898
Publisher:

I*Platefﬂgure [eg p 257] Eingliga Svenska Vetenskaps Akademiens Handlingar, wol 32 (3): 1-

pl. 2, fig. 4 a1

Insert |

Search for Reterence

Tour registered synonyms & references

Remember to click “Insert” before continuing to add more syn/refs or going to the “Image”-page.

Image

Preparing images before submission: Before adding images, please make sure they are
250 pixels wide and on the jpg format. This can easily be achieved using Adobe
Photoshop/Corel Photo Paint (or another image application):

If your e Openimage...
picture is Menu: File -> Open (select image)
larger than e Resize to 250 pixels wide...
250 pixels Menu: Image -> Image size -> set to 250 pixels (remember to
check constrain proportions checkbox)
e Save for web...
Menu: File -> Save for web -> select jpg/jpeg from the pulldown
e Ifasked about quality select “high”/60
If your e Open image...
picture is Menu: File -> Open (select image)
smaller than e Resize to 250 pixels wide...
250 pixels Menu: Canvas size -> set width to 250 pixels (remember to have
the white box in the middle)
e Save for web...
Menu: File -> Save for web -> select jpg/jpeg from the pulldown
e If asked about quality select “high”/60

Add an image by browsing your computer. If possible fill in on the information regarding
Sample (e.g. MD95-2011), Location (e.g. Nordic Seas), Latitude (e.g. 66.5818N),
Longitude (e.g. 07.3836E) and the name of the person who took the pictures. Additional
information can be posted under Comments.
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Ra.d,f,oiammforg/ | Home =

Intre P species P other descrption P synonymireference P image P preview
Image

* Image [Jpg from your computer) Clomtnents
ID:\RadiDIaria_Drg\NDrd Browse. . | ;l
Sample [e.g MDE5-2011]
[pMD95-2011

Location
|Nordiu: Seas

Latitude [e.2 66.58181] Jid
[BE.5518M

Longitude [e.g. 07.3836E]
07.3836E

Phaoto by

I.Jane K. Dolven

Insert

‘Radmlar;wcwgf | Home =

Intro P species B other description P synonymireference P image P preview

Image
* Image [ jpg from vour computer] Comments

Browse... | ﬂ

Zample [eg WMD%5-2011]

Location

Latitude [e.g 66 58181] =l

Longitude [e.g. 07.3836E]

Photo by

|
Insert |

Tour registered images

Sample
MDe5-2011

Location

Hordic Seas

Latitude
66581817

Longitude
07 3836E

Photo by
Jane E. Daolven

Comments
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Preview

Once you completed the data entry, you can preview the contributed information. If you
find mistakes you can click on one of the links on top of the page and correct/change
what you have submitted. Do not use the “Back” button in your browser!

p species p other description p synonym/reference p Image p preview

RWWWOYQ/ | Home>

Intro P species P other description P synonymireference P image P preview

Teur registered Species
Fhizaplegma boreale
(Cleve) - 1899

spumellaria - Mordic Seas

Tour registered descriptions

(Cleve)  189% Hezadoras borealis: Primordial shell: rregularly spherical, 0.03 to 0. 0dmm in diameter with irregular,
rounded of polygonal pores, 2 to 3 on the radig, and thin bars. Spines sz, exceptionally more, strong, with
triangular apophyses m the middle. Outer shell a rounded or octahedral, more or less mtricate networlk: of
anastomostng, silicecus threads, 1ssuing from the prommal edges of the spines. Spines usually six (rarely as
m Rhizoplegma 8 to 10) strong, three-sided, and shghtly spirally twisted, with elegantly aculeate, winged
edges.

Jergensen 1905 Bluroplegma boreale: Easily recogrized by the charactenstic interwoven pyrarmds around the main spines.
Haeckel depicts stmilar pyramids for Ehizoplegma lychnosphera The mside shell is irregular, not quite
round, sometitnes resetnbling a cube in shape, sometitnes it 15 more ke an octahedron. The pores are
uneven, irregular, polygonal, averaging about 10pm. The mtermediate walls between the pores are not
broad, differently developed, but never hawving the distinct broader corners which cotrespond to the
rounded lumen of the pore. & few small, short, needle-shaped byspines are found here and there on the
beatns, but not regulatly in the corners.

Tour registered synonyms and references
Hexadoras borealis - Clewe | 1853 Cleve, P.T.. - 189%a
Rhiroplegma boreale - Jorgensen , 1905 Jorgensen, E., - 1905

Your registered images

Sample:
MDa5-2011

Location:
Mordic Seas

Latitude:
6658181

Longitude:
07.3836E

FPhoto by
Jane ¥ Dolven

Comtnents:

Tmage

Information about youl

Teur name:

|Jane K_Diolven Please enter your name and your email

Tour email: Thiz will make it possible for us to contact vou. Your contribution will become otline as soon
|jane@radio|aria.org as possible.

| Subrmit Species I Thank you for your contribution.

After approval, write your name and e-mail address and click on the “Submit Species”-button.
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Adding info to an already registered species:

Description, synonyms and references

Additional descriptions, synonyms and references can be added by clicking on the “Add
descriptions”, “Add synonym” and “Add reference” under each species. Please follow the
same standard as described above.

Distribution
If you would like to add information on the distribution of a species that is already in the
system please make sure:

1: That the species has been documented (described/pictured) in one or more papers.
Please send the reference (of this book/journal) to team@radiolaria.org so they can add
this publication as a reference under the species.

2: If possible, please also document the species (in the area you have clicked off) by
adding your own photo (preferable with a scale bar) at the “Image”-page. Please make
sure to include sample location (e.g. Nordic Seas), latitude/longitude of the sample and
your name. If you prefer you can also e-mail your photo and information to
team(@radiolaria.org, and they will add it for you.

3: If the species is new to the region (not documented by a publication), you are allowed
to register the species only if you provide a picture with information (se above).

4: Finally, to register the species you need to click of the appropriate checkbox(es), fill in
your full name and e-mail address in the textboxes at the bottom of the page, and press
“submit”. Your additions will become visible after a web editor has made them online. If
any question(s), the web editor will make contact with you.

Discussion/Comments

Under this forum radiolarian researchers can exchange ideas and opinions, add comments
and suggestions, and post related non-published material about a particular species.
Adding a comment can be done by filling out the forms under “New
comment/discussion” found under each species.

Web link
When adding a web link please include a title and short description in additional to the url.
e.g.  Boltovskoy, 1998
Cornutella profunda: fig. 15.127.
Note that the url must include http:// (E.g. http:/palaco-electronica.org/1998_2/boltovskoy/fig15127.htm)

Problems/bugs

Radiolaria.org is still under development and we are constantly trying to improve the site.
If you come across problems or bugs please report this to jane@radiolaria.org or
hans@one.no, and we will do our best to help you. Good luck with your contributions
and thank you for submitting to Radiolaria.org!

Radiolaria.org team
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